




Es una metodología ágil y flexible que se
utiliza para gestionar proyectos, su
principal objetivo es apoyar proyectos
donde el entorno de estos es muy
cambiante en cuanto a tecnologías,
requerimientos y equipos, maximizando el
retorno de la inversión (ROI) al cliente.

https://agileroad.com/es/blog/metodologias-agiles.html


http://www.youtube.com/watch?v=9TycLR0TqFA


Utilizando Scrum:

● Se mejora la calidad del producto final.
● Se mejora la productividad de los integrantes.
● Se realiza un seguimiento diario de los avances

del proyecto
● Se realizan iteraciones cortas.
● Se realizan sprints, con entregables semi-cerrados

que sirven para que el cliente pueda obtener los
beneficios del proyecto en forma incremental,

● Los entregables deben ser presentados como un
resultado finalizado, lo que se conoce como
incremento de producto.

Esto le permite ver al cliente el progreso y resultado del
proyecto en varias etapas dentro del mismo proyecto.



Se trabaja con iteraciones cortas
(Sprints), donde cada iteración debe
representar un incremento de
producto que pueda ser presentado
al cliente como un resultado
finalizado.



Las características a desarrollar durante
cada iteración salen del Product
Backlog: Nombre con el que se conoce
al conjunto de requisitos priorizados.

Estas características se determinan al
inicio de cada sprint, en la reunión
que se conoce como Sprint Planning.

Imagenes tomadas de: https://www.freepik.es/

https://www.freepik.es/


En esta reunión el Product Owner en conjunto
con el equipo determinan que elementos del
Product Backlog se pueden comprometer a
desarrollar y se clarifican las historias
seleccionadas.

Esta nueva lista de tareas a realizar se conoce
como Sprint Backlog. Una vez comenzado el
sprint, tanto las historias que conforman el Sprint
Backlog como los requerimientos de las mismas
no pueden ser modificados.

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/


Se realizan reuniones diarias (Daily Scrum) durante
el sprint con el fin de mantener la comunicación y
la productividad del equipo.

En estas reuniones cada integrante participa
respondiendo a 3 preguntas:

● ¿En que trabajó el último dia?,
● ¿En que va a trabajar hoy?,
● ¿Hay alguna tarea que se vea bloqueada por

algún motivo?

Es el Scrum Master el que debe asegurar que el
equipo pueda cumplir con su trabajo.

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/


Sprint Review

Aquí analiza el trabajo realizado, que ítems fueron
terminados y cuáles no y se presenta al cliente el
trabajo finalizado.

Sprint Retrospective

Aquí los integrantes del equipo dan su opinión
sobre el sprint finalizado y se proponen mejoras
sobre el proceso.

Una vez finalizado el sprint se realizan 2 reuniones más:

Imagenes tomadas de: https://www.freepik.es/

https://www.freepik.es/




Se trata de un sistema operativo diseñado para
dispositivos táctiles que van desde teléfonos
celulares, pasando por relojes inteligentes y
Android TV, hasta automóviles.

El mismo fue creado por Google y estaba
basado en el sistema Linux, actualmente es
considerado el sistema operativo más utilizado a
nivel mundial.



Desde el punto de vista etimológico Android
(androide en español), en el caso particular
del nombre del sistema operativo se basa en
“¿Sueñan los androides con ovejas
eléctricas?” de Philip Dick.

Por otra parte, el término androide en
español proviene del griego andro, que
significa hombre y la palabra eidos que hace
referencia a una apariencia o imagen.



Desde su lanzamiento y hasta el día de hoy, Android ha recibido numerosas actualizaciones.
Diferentes versiones del sistema que han ido arreglando fallos detectados, añadiendo nuevas
funciones, soportes para nuevas tecnologías, etc. Unas versiones que curiosamente han sido
desarrolladas bajo un nombre en código de un elemento relacionado con postres o dulces y que
además ha ido respetando rigurosamente un orden alfabético.

● Android Apple Pie: versión 1.0 y fecha de lanzamiento 23 de septiembre de 2008.
● Android Banana Bread: versión 1.1 y fecha de lanzamiento 9 de febrero de 2009.
● Android Cupcake: versión 1.5 y fecha de lanzamiento 25 de abril de 2009.
● Android Donut: versión 1.6 y fecha de lanzamiento 15 de septiembre de 2009.
● Android Eclair: versión 2.0-2.1 y fecha de lanzamiento 26 de octubre de 2009.
● Android Froyo: versión 2.2-2.3 y fecha de lanzamiento 20 de mayo de 2010.
● Android Gingerbread: versión 2.3-2.7 y fecha de lanzamiento 6 de diciembre de 2010.
● Android Honeycomb: versión 3.0-3.2.6 y fecha de lanzamiento 22 de febrero de 2011.



● Android Ice Cream Sandwich: versión 4.0-4.0.5 y fecha de lanzamiento 18 de octubre de
2011.

● Android Jelly Bean: versión 4.1-4.3.1 y fecha de lanzamiento 9 de julio de 2012.
● Android Kitkat: versión 4.4-4.4.4 y fecha de lanzamiento 31 de octubre de 2012.
● Android Lollipop: versión 5.0-5.1.1 y fecha de lanzamiento 12 de noviembre de 2014.
● Android Marshmallow: versión 6.0-6.0.1 y fecha de lanzamiento 5 de octubre de 2015.
● Android Nougat: versión 7.0-7.1.2 y fecha de lanzamiento 15 de junio de 2016.
● Android Oreo: versión 8.0-8.1 y fecha de lanzamiento 21 de agosto de 2017.
● Android Pie: versión 9.0 y fecha de lanzamiento 6 de agosto de 2018.
● Android 10: versión 10.0 y fecha de lanzamiento 3 de septiembre de 2019.
● Android 11: versión 11.0 lanzado el 8 de septiembre de 2020.





https://developers-
latam.googleblog.com/2020/06/android-studio-40.html https://developer.android.com/studio?hl=es-419

https://developers-latam.googleblog.com/2020/06/android-studio-40.html
https://developers-latam.googleblog.com/2020/06/android-studio-40.html
https://developer.android.com/studio
https://developer.android.com/studio?hl=es-419


Si descargaste un archivo .exe
(recomendado), haz doble clic en él
para iniciarlo.
Si descargaste un archivo .zip, extráelo
y copia la carpeta android-studio en la
carpeta Archivos de programa. A
continuación, abre la carpeta android-
studio > bin y, luego, inicia
studio64.exe (para máquinas de 64
bits) o studio.exe (para las de 32 bits).

Sigue los pasos del asistente de
configuración en Android Studio y
asegúrate de instalar los paquetes
de SDK que recomiende.



Ejecuta el archivo 
DMG de Android 
Studio.

Arrastra y suelta 
Android Studio en la 
carpeta Aplicaciones 
y, luego, inícialo.

Elige si deseas 
importar 
configuraciones 
anteriores de Android 
Studio y, luego, haz 
clic en OK.

El asistente de 
configuración de Android 
Studio te guiará por el 
resto de la configuración, 
lo que incluye la descarga 
de los componentes del 
SDK de Android que se 
necesiten para el 
desarrollo





Paso 1

Lo primero que verás al abrir Android

Studio por primera vez es una pantalla

como esta:

En ella simplemente se te pregunta si quieres
importar la configuración de una versión
anterior. Generalmente Android Studio:

● Detectará la configuración por sí mismo.

● Y si no tienes ninguna configuración
anterior guardada se marcará Do not
import settings, o no importar configuración



Paso 2

La siguiente ventana que te aparecerá te pide

permiso para enviar datos de uso y

estadísticas a Google, con el objetivo de que

sean usados para mejorar la aplicación. Es

totalmente opcional, así que acéptalo con

Send usage statistics to Google o no, en

este caso haciendo clic en Don't send.



Paso 3

Tras este pre-asistente de configuración
viene el asistente de configuración. En
verdad son solo un par de ventanas con
las opciones de configuración más
importantes y que, en cualquier caso,
siempre podrás cambiar más tarde desde
los ajustes.



Paso 4

Lo primero que se te pregunta es si quieres
hacer una instalación estándar o personalizada
de Android Studio. En la gran mayoría de los
casos, la instalación estándar es suficiente y te
ahorrará tiempo y algún que otro quebradero
de cabeza.



Paso 5

A continuación debes elegir qué tema vas a usar en

el editor de código.

De fábrica trae dos: el tema claro Light y el tema

oscuro Darcula. Elige el que más te convenza,

aunque siempre lo podrás cambiar más tarde desde

las opciones, así como personalizar todos los

colores y fuentes si así lo deseas.





La aplicación Android "Hello world" terminada se 
verá así:

Para crear esta simple aplicación Android, sigue 
estos pasos:

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/


1. Ejecuta Android Studio, y
deberías ver una página de
bienvenida, como se muestra
a continuación.



2. En la página de bienvenida anterior,
haz clic en Start a new Android Studio
project (Comienza un nuevo proyecto
de Android Studio).

La siguiente ventana presenta la
página de las actividades, así:



3

Cada actividad tiene una ventana
en la que puede desplegar su
interfaz de usuario.

4

La ventana normalmente llena la
pantalla, pero puede ser más
pequeña que la pantalla y flotar
por encima de otras ventanas.

1

Para el proyecto "Hello world"
elegir Empty Activity (Actividad
vacía) y dar clic en Next
(Siguiente)

2

Una actividad es un componente
crucial de cualquier aplicación
Android. Esta proporciona una
pantalla con la que los usuarios
pueden interactuar para llevar a
cabo actividades, como marcar el
teléfono, tomar una fotografía o
enviar un mensaje.

Android Studio proporciona plantillas de actividades para ayudar a comenzar:



Terminaremos de crear el proyecto configurando
algunos detalles sobre su nombre, ubicación y qué
versión de API utiliza.

● Cambiar el nombre de la aplicación.
● Cambiar el valor predeterminado de Project location

(Ubicación del proyecto) a tu directorio preferido, o
simplemente déjalo con la ubicación predeterminada.

● En el Minimum API level (Nivel de API mínimo),
asegúrate de que la API 15: Android 4.0.3
IceCreamSandwich esté configurada como el SDK
mínimo: esto garantiza que tu aplicación pueda
ejecutarse en casi todos los dispositivos.

Dar clic en Finish (Finalizar)



Cada vez que creas una nueva aplicación, Android Studio
crea una carpeta para tus proyectos y compila el proyecto
con su sistema Gradle.

El proceso de Gradle puede tardar unos minutos.

Gradle es el sistema de compilación de Android, que es
responsable de la compilación, prueba y despliegue del
código.

Este permite que la aplicación se ejecute en el
dispositivo.





Cada vez que comienzas un proyecto
nuevo, Android Studio crea la
estructura de carpetas y archivos
necesarios para esa aplicación.

Echemos un vistazo a los diferentes
archivos involucrados en un proyecto
de aplicación de Android.



La carpeta manifest

La carpeta manifests contiene el archivo
AndroidManifest.xml. El archivo
manifiesto describe información esencial
sobre tu aplicación.

La carpeta java

Esta carpeta contiene los archivos del
código fuente de Java. Como puedes ver
arriba en la ventana del editor, el archivo
MainActivity.java contiene el código
fuente de Java para la actividad principal
de la aplicación.



La carpeta res/layouts

Los diseños son archivos XML que definen
la arquitectura de la interfaz de usuario en
una actividad o en un componente de una
interfaz de usuario.

Por ejemplo, en nuestra aplicación, el
archivo activity_main.xml corresponde a
la actividad principal.

La carpeta res/values

Contiene los archivos XML que se usarán
para el color, estilo y las cadenas para la
aplicación.



La carpeta res/drawable

Este es un repositorio general para todos
los gráficos que pueden ser dibujados en
la pantalla, por ejemplo las imágenes.

El archivo build.gradle

Este es un archivo generado
automáticamente que contiene
información sobre los detalles de la
aplicación, por ejemplo la versión del SDK,
la versión de las herramientas de
compilación, el ID de la aplicación y más.



Ahora que tienes un panorama 
general de la estructura del proyecto, 
describamos los archivos 
componentes más críticos que 
constituyen a la aplicación "Hola 
mundo".

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/


La actividad principal

Es la primera pantalla 
que aparecerá 

cuando ejecutes tu 
aplicación

Cada actividad 
representa una 
pantalla de la 

interfaz de usuario 
en la aplicación 

Android

Cada actividad tiene 
un archivo de 

implementación 
Java (o Kotlin) y un 
archivo de diseño 
XML en Android



A continuación se encuentra el código Java
predeterminado generado por la aplicación para la
actividad principal.

No es necesario comprender este código en su
totalidad. Mucho de él es repetitivo y será el mismo para
cualquier aplicación.

El código define una clase MainActivity, y define lo que
ocurre cuando se crea la actividad con el método
onCreate.

En este caso, simplemente inicializa la vista de la actividad con el diseño del archivo activity_main.xml.



Los archivos XML se usan para los diseños. El
archivo de diseño XML de la actividad principal se
encuentra en el directorio
/app/src/main/res/layout del proyecto. Los
archivos de diseño son nombrados de acuerdo a lo
que representan. Por ejemplo, la aplicación "Hola
mundo" tiene un diseño, que es el
activity_main.xml, cuyo nombre se basa en la
actividad principal.

Este es el diseño predeterminado
activity_main.xml. Este contiene un elemento
TextView, con el texto Hello World! (¡Hola mundo!).



Como puedes ver, no necesitamos
cambiar mucho para terminar nuestra
aplicación "Hello world", pero
haremos un pequeño cambio para
que el texto destaque más:
cambiaremos el color y el tamaño de
la fuente del texto.





Conecta tu dispositivo Android a
tu computadora con un cable
USB. El tipo de conexión correcto
debería aparecer como connected
as a media device (conectado
como un dispositivo de medios).

Imagen tomada de: https://www.movilzona.es/2020/04/30/modo-depuracion-usb-android/

https://www.movilzona.es/2020/04/30/modo-depuracion-usb-android/


Paso 
1

Abre el menú 
Settings

(Configuraciones) en 
tu teléfono Android y 
desplázate hasta la 

parte inferior.

Pulsa en About phone
(Acerca del teléfono) y 

desplázate hacia 
abajo de nuevo hasta 

que veas la opción 
Build number (Número 

de compilación).

Paso 
2

Pulsa en el número de 
compilación varias 

veces. Pronto deberías 
ver una ventana 

emergente que dice 
algo similar a You are 
five taps away from
being a developer

(Estás a cinco 
pulsaciones de ser un 

desarrollador).

Paso 
3

Sigue pulsando 
hasta que la 

ventana emergente 
diga que eres un 

desarrollador.

Paso 
4

Regresa al menú 
principal Settings > 
System > Advanced
(Configuraciones > 

Sistema > Avanzado).
Las opciones de 

desarrollador deberían 
ser la penúltima opción. 
Activa las opciones de 

desarrollador.

Paso 
5

En Android Studio navega 
hasta el menú superior y 

selecciona Run 'app'
(Ejecutar 'aplicación'). 

Android Studio mostrará un 
cuadro de diálogo en el 

que puedes elegir en qué 
dispositivo ejecutar tu 

aplicación Android. Elige el 
dispositivo que conectaste 
y haz clic en el botón OK

Paso 
6

También necesitarás tener habilitadas las opciones de desarrollador en tu

dispositivo. Si esto aún no está habilitado, sigue estos pasos (esto funcionará

en la mayoría de los dispositivos Android):



La aplicación "Hola mundo" ahora debería estar
ejecutándose en tu teléfono. Desde aquí puedes
modificar tu aplicación según lo que desees y
agregar más funciones.

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/




http://www.youtube.com/watch?v=5rkmsYF8ASI


● Simula dispositivos Android en una computadora
para que puedas probar tu app en diferentes
dispositivos y niveles de API de Android sin
necesidad de contar con los dispositivos físicos.

● Proporciona casi todas las funciones de un
dispositivo Android real.

● Puedes simular llamadas y mensajes de texto
entrantes, especificar la ubicación del dispositivo,
utilizar diferentes velocidades de red, probar
sensores de rotación y otros sensores de hardware,
acceder a Google Play Store y mucho más.

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/


● En algunos casos, probar tu app en el emulador es
más rápido y fácil que hacerlo en un dispositivo
físico. Por ejemplo, puedes transferir datos con
mayor velocidad al emulador que a un dispositivo
conectado mediante USB.

● El emulador incluye configuraciones predefinidas
para varios teléfonos y tablets Android, Wear OS y
dispositivos Android TV.

Imagen tomada de:https://www.freepik.es/

https://www.freepik.es/


Además de los requisitos de sistema básicos para
Android Studio, Android Emulator tiene los siguientes
requisitos adicionales:

● Herramientas del SDK 26.1.1 o versiones
posteriores

● Procesador de 64 bits
● Windows: CPU con compatibilidad para UG

(invitado no restringido)
● HAXM 6.2.1 o posterior (se recomienda HAXM 7.2.0

o posterior)

Imagen tomada de:https://www.freepik.es/
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El uso de la aceleración de hardware implica requisitos
adicionales en Windows y Linux:

● Procesador Intel en Windows o Linux: procesador Intel
compatible con Intel VT-x, Intel EM64T (Intel 64 Bit) y
funcionalidad Execute Disable (XD)

● Procesador AMD en Linux: procesador AMD compatible
con AMD Virtualization (AMD-V) y extensiones
complementarias de transmisión SIMD 3 (SSSE3)

● Procesador AMD en Windows: Android Studio 3.2 o
posterior, y Windows 10 lanzado después de abril de 2018
para Windows Hypervisor Platform (WHPX)

Imagen tomada de:https://www.freepik.es/

https://en.wikipedia.org/wiki/SSSE3
https://docs.microsoft.com/en-us/virtualization/api/
https://www.freepik.es/




Cada instancia de Android Emulator usa un
dispositivo virtual de Android (AVD) para
especificar la versión de Android y las
características del hardware del dispositivo
simulado.

Si quieres probar tu app de manera eficaz,
deberás crear un AVD que modele cada
dispositivo en el que se ejecutará la app
según su diseño. Para crear y administrar
AVD, usa el Administrador de AVD.Imagen tomada de: https://blogsaverroes.juntadeandalucia.es

https://developer.android.com/tools/devices/managing-avds?hl=es-419
https://blogsaverroes.juntadeandalucia.es


● Cada AVD funciona como un dispositivo
independiente, con su propio
almacenamiento privado para datos del
usuario, tarjetas SD, etc.

● De forma predeterminada, el emulador
almacena los datos del usuario, el contenido
de la tarjeta SD y la memoria caché en un
directorio específico para ese AVD.

● Cuando inicies el emulador, este cargará los
datos del usuario y el contenido de la tarjeta
SD desde el directorio del AVD.

Imagen tomada de: https://blogsaverroes.juntadeandalucia.es

https://blogsaverroes.juntadeandalucia.es


Puedes ejecutar una app desde un proyecto de 
Android Studio o ejecutar una que se haya instalado 
en Android Emulator de la misma manera en que lo 
harías con cualquier app en un dispositivo.

Para iniciar el emulador y ejecutar una app desde tu 
proyecto, haz lo siguiente:

1. En Android Studio, crea un dispositivo virtual de Android 
(AVD) que el emulador pueda usar para instalar y 
ejecutar tu app.

2. En la barra de herramientas, selecciona el AVD en el 
que deseas ejecutar la app desde el menú desplegable 
del dispositivo de destino.

3. Haz click en Run

https://developer.android.com/studio/run/managing-avds?hl=es-419#createavd


Si recibes un mensaje de error o de advertencia en la
parte superior del diálogo, haz clic en el vínculo para
obtener más información o corregir el problema.

Debes corregir algunos errores para poder continuar,
como ciertos problemas del Hardware Accelerated
Execution Manager (HAXM de Intel).

En Mac, si aparece el error Warning: No DNS servers
found cuando inicias el emulador, verifica si tienes el 
archivo /etc/resolv.conf. Si no lo tienes, ingresa el 
siguiente comando en una ventana de terminal: ln -s 

/private/var/run/resolv.conf /etc/resolv.conf



Ejecuta Android Emulator directamente en
Android Studio para:

● Conservar el estado real de la pantalla.
● Navegar rápidamente entre el emulador y

la ventana del editor con teclas de acceso
rápido.

● Y organizar el flujo de trabajo del IDE y el
emulador en una ventana de aplicación
única.



Para ejecutarlo en Android Studio, asegúrate de usar
Android Studio 4.1 o superior con la versión 30.0.10
o una versión posterior del emulador, y seguir estos
pasos:

1. Haz clic en File > Settings > Tools > Emulator (o Android
Studio > Preferences > Tools > Emulator en macOS),
selecciona Launch in a tool window y haz clic en OK.

2. Si la ventana del emulador no aparece
automáticamente, haz clic en View > Tool Windows >
Emulator.

3. Para iniciar el dispositivo virtual, utiliza el
Administrador de AVD o establécelo como destino
cuando ejecutes tu app.


